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MICROSOFT WORD 

Microsoft Word Is The Part Of Ms Office. Microsoft Word Is Also Known As Word Processor Software. It Enables You To Create, 

Edit, Print And Save Documents For Future Retrieval And Reference.  It Is Used To Create Letter, Application, Bio-Data Etc. It’s File 

Extension Is Docx. Example of Word-processing Software are Google Docs , Libre Writer , Word Perfect & Open office writer. 

At  the  very  top  of  the  screen  the  old  menu  system  has  been  replaced  by  a  new Office button, which holds many of  the 

commands which used  to  be in  the File menu Access toolbar,  which  can  be  customized  with  your  own  choice  of  command 

buttons. On the far right are redesigned Minimize, Maximize/Restore and Close buttons 

The Office Button : It is the round icon at the top left-hand corner. It includes the basic File Functions from the older version of 

Office New, Open, Save, Save As, Print, etc. Click on the Office Button icon. You will see the main file functions in the pull-

down menu. 

Quick Access Toolbar Next to the Office button is the Quick Access Toolbar, which contains items you use 

regularly, e.g. the Save button, and the Undo and Redo last action buttons. 

The Ribbon : The most outstanding feature of Word 2007 is the Ribbon, which replaces the menus and toolbars found in previous 

versions of Microsoft Word. 

The ribbon consists of three areas: 

Ribbon Tabs : These are at the top of the ribbon, e.g. Home, Insert, Page Layout, etc. 

Groups : Each tab has its own set of groups – e.g. the Home tab contains the Clipboard, Font, Paragraph, Styles and Editing groups.   

Dialog Box Launcher : Some groups also have a small button in the lower right-hand corner , from which further 

options are available.  When a different tab is selected, the groups change accordingly. 

Commands : These are the buttons, boxes or menus relative to each group, e.g. the alignment, and bullets and 

numbering buttons are in the Paragraph group, while Find and Replace are in the Editing group.  

 

Status Bar : It is the bar at the bottom of the window can display items such as the current page number, section, 

number of words in the document, etc.  Right-click on bar, to select the options you require. 

                                                Zoom Slider : In the bottom-right hand corner of the window, on the status bar, is 

the Zoom slider.  To view your document at different percentages, click the plus or minus buttons. 

                        Document View Buttons : These are situated next to the Zoom Slider. Simply click one of the five 

buttons to view your document as Print Layout, Full Screen, Web Layout, Outline or Draft. 
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 Do You Know 

MINIMUM FONT SIZE : 1 POINT   MAXIMUM FONT SIZE : 1638 POINT 
MINIMUM ZOOM : 10%                                                                 MAXIMUM ZOOM : 500% 

Extension Of M.S. Word 1997,2000,2003 : DOC     Extension Of M.S. Word 2007,2010,2013,2016,2019 & 2021 : DOCX 

OLDEST NAME OF M.S. WORD : WORDSTAR 
EXAMPLE OF SUBSCRIPT : H2O ( CTRL+= )  EXAMPLE OF SUPERSCRIPT : 27.50 (CTRL+SHIFT++) 

POSITION OF GUTTER : LEFT & TOP  FONT STYLE : REGULAR, ITALIC, BOLD & BOLD ITALIC 
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HOME TAB 

Clipboard Group : The Home ribbon is made up of the most used commands in Word.  The first group on the Home   

ribbon is the Clipboard.   Cut ,Copy , Paste and Format Painter are the commands within the Clipboard group.   

Cut is used to cut any content in to clipboard.  Copy is used to copy any content into clipboard. 

But content should be selected.  

Format Painter is used to copy any formatting from one place & apply to another. 

Paste : Paste the contents of clipboard which you cut or copy earlier.  

The dialog expander arrow of the Clipboard group will open up the Clipboard pane, showing all items that can be pasted.  You can 

now have up to 24 items in the Clipboard pane. 

Font Group 

The second group of commands on the Home ribbon is the Font group.  The font group 

commands are format enhancing tool that includes Font Types, Font Size, Font Effects ,Colors and 

more. 

Font : To change the font face like Times New roman ,Century, Arial Etc.. 

Font Size : To change the font size from 1-1638. 

Grow & Shrink Font : To Increase & Decrease the font size respectively. 

Clear Formatting :  To clear all the formatting from the selection & leave only plain text. 

Font Effects : To apply the Bold, Italic, Underline ,Strikethrough, Subscript & Superscript Effects on text. 

Change Case : To change the text in to Sentence Case (To change first letter of sentence in to capital letter ),Lowercase ( All letters 

change into small letters),Uppercase(All letter change into capital letters), 

The expander arrow in the Font group will open up the Font dialog window. 

The Third group of Commands on the Home Tab is the Paragraph Group. It contains 

Alignment , Bullets , Numbering ,Indents, Line spacing ,  Shading Sort & Border. 

Alignment : To change the alignment of text, first select it, then select the Desired Alignment 

( Left ,Right , Center & Justify ). 

Bullets : To apply the bullets on Selected List. In define New bullet , we can customize the bullet. 

Numbering : To apply the numbering on Selected List. In define New Number Format, we can customize the Numbering Style. 

Indent : Select the paragraph or section of text that you want to indent. You can Increase or decrease the indent. 

Sort : To sort the selected list in Ascending or Descending order. 

Line Spacing : To apply the Spacing between lines. 

Shading : To apply the Shading on text. 

Bottom Border : To apply border on text or paragraph. We can customize Border.  

Show & Hide : To show & Hide the Non Printing Character :  

The Styles group is going to make the biggest impact 

in your document layout and design.  

A style is a set of formatting settings, such as font 

type, size, color, paragraph alignment, spacing and 

graphic settings. When you use these readymade styles 

to format your document, you can quickly and easily apply a set of formatting choices consistently throughout your document. Here is 

a screen capture of the different styles with a preview of what they look like on top. 

Editing Group consist the following Tools 

Find : To Find any word in a Document. 

Replace : To Replace Any word with new one. 

Select : To select the text or object. In Select all the text and object, Select object is used to select all the object only , 

Select text with similar formatting is used to select the text with same formatting. 

 

 

 

 

 

 

Do you Know 

Document Views : Print Layout , Read Mode , Web Layout , Outline , Draft 

Alignment : Left , Right , Center & Justify 

Default Tab Setting : 0.5 Inch      Margins : Top, Bottom, Left, Right 
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INSERT TAB 

The three categories you can insert for pages are; Cover Page, Blank Page, and Page Break. These three 

features are useful if you are creating a professional or long document. 

In Cover Page we have already designed cover pages that is used for a business report or other professional 

document. Click on the design you want. You can customize the page also. In Blank Page , When you are 

typing a long document as you type a new page will automatically start as you are typing. The Blank Page 

button allows you to insert a blank page anywhere in your document manually.In Page Break , this button will 

force a page break anywhere you select. You will see this  in your document if you click the page 

break button. To delete a page break place your cursor behind the Page Break and press the Backspace button. 

 

 

Table : It is used to draw table. After Draw the table you can customise whole the table by :  
 

 

Design Tab Under Table Tool Is Appear Only When Table Is Used   

Design Tab is used to  apply and control table styles, shade a cell, or apply a border. 

 

Layout Tab Under Table Tool Is Appear Only When Table Is Used 

Layout tab is used to insert or delete cells, columns, or rows, automatically size columns, sort data in a table, merge or split 

cells, and convert a table to text. 

Illustrations are used to add pictures and drawings of all type and styles to your document. 

Picture :  Insert a picture from a file. When you click on the Picture button a window will open 

for you to browse to a photograph or other picture you have saved on your computer. 

Clip Art : After clicking on the Clip Art Button , the clip art menu appears in the right side of 

your document. At the top of the Clip Art menu in the Search , type birthday and click go. 

 

PICTURE TOOLS UNDER FORMAT TAB contains 

 

Adjust group is used to adjust brightness , contrast , change the picture. 

Picture style group is used to apply the border & effects on a picture  

Arrange group is used for align , rotate , group or ungroup & text wrapping . 

Size group is used to set the height & width of a picture. 

Shapes : If you click the drop down arrow on shapes you will see a long list of shapes you can insert into your document. To insert a 

shape simply click in the location of your document you want the shape to appear and click the shape. 

Drawing Tools Tab is Appear When Shape Tool is used 
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Drawing Tool : Insert Group is used to insert different Shapes. 

Shape Style : To Apply different style on current shape of the document. Here You can also Fill the color in a Shape,Change the 

outline & Change the shape. 

Shadows EfFects : To apply the Shadow & Also adjust the shadow. 

3-D Effects : To apply the 3-D Effects on a shapes. 

Arrange :  To Set the Alignment, Position of the Shape. Rotate   

SMART ART 

Smart Art is a unique tool. SmartArt will automatically design graphically designed lists, hierarchy charts, pyramids and more. 

SmartArt will put the graphics into your document and you can customize it by highlighting and changing the text. 

CHART 

It is used to create the chart you would like then automatically open an Excel spread sheet for you to enter the data to create your chart. 

 

 Hyperlink : It is used to create link with another file. 

 Bookmark :  A bookmark is used to create a name for a specific section of your document.To use the 

Bookmark button place your mouse cursor in the spot on your document you would like to bookmark and click 

the Bookmark button and it will open the Bookmark window. In this window you type the name of your book 

mark in the top text box and click the Add button. This will add your book mark to the list. 

 

Header : It is used to insert Header on the top of the page. 

Footer : It is used to insert Footer at the Bottom of the page. 

Page Number : It is used to inser page number at different positions. 

 

   Text Box : It is used to insert text box at different positions.You can also draw text box. 

   Word Art :  To Write theDecorative text in different style. 

    Drop Cap : To Create the first Alphabet in Capital of the paragraph. 

   Date & Time : To insert Date & Time different available formats. 

 Object : To insert any object or text from any other package. 

 

          Symbol : It is uesd to insert Special Symbol like Copyright(©),Registered Trade Mark®) Etc…. 

 

PAGE LAYOUT TAB 

 

 

Themes is used to apply different formatting like font , color & Effects on Entire Document.You can also customize 

Color , Font & Effects. 

 

Margins : To apply margins in a Document Like Normal , Naroow , Moderate , Wide , 

Mirrored , Office 2003 Default . You can also customize Margins. 

Orientation : To set the orientaion landscape or Portrait 

Size : To set the Paper Size. 

Columns : To Split the page into columns . 

Breaks : Breaks gives you the option to format different sections of your document separately. You can insert page breaks or section 

breaks. If you would like one page with columns and another without this is the feature you would use by inserting a page break. 

Line Numbers :  If you are editing a long document and need to make references or corrections. This is a great feature. When you make 

a selection you will see a line number in the left hand margin of your document. You can see in the drop down menu you have several 

options for the formatting of your line numbers. 

Hyphenation  : When you select an option from the dropdown menu it will hyphenate words that are at the edge of your document. This 

can be very useful when typing newsletters in a column format. 
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Watermark : To insert any image or text at background of the text. 

Pagecolor : To apply the color or effects on a page. 

Page Border : To apply the border on a text , page or pararaph. 

 

 

 

Indent : To set the left & Right Indent of a Paragraph. 

Spacing : To set the line spacing & also set the space before & after paragraph. 

 

 

 

 

 

               To Rotate , Group or Ungroup ,Text Wrapping , Alignment of the Object. 

 

 

REFERENCE TAB 

 

 

                                             It is used to make a table of content ( For e.g  Chapter Information ). 

 

 

 

 

             Footnote :  A footnote is used to comment on or provide a reference for text in a document.   

A note reference mark next to the sentence or line you are referencing. The footnote text at the 

bottom of the page. To add a footnote to your document select the location you want your reference 

mark to appear then click the Insert Footnote button. Footnotes are usually for detailed comments 

and endnotes are used for citations 

Endnote : To insert an Endnote click in the location you want the reference mark then click on Insert Endnote and it will be placed at 

the bottom of your document and allow you to type your endnote. 

Next Footnote : To scroll between all of your footnotes and endnotes click the Next Footnote button. This button gives you the options 

to go to the next or previous endnote and footnotes.  

Show Notes : Show Notes scrolls through the document to show you where all of your footnotes and endnotes are located. The show 

notes button will be grayed out until you have footnotes inserted into your document. 

 

     

    It is used to put a caption with pictures or to label tables and objects  you insert into your word 

documents. The first button is Insert Caption. To insert a caption on a picture or object then click the Insert 

Caption button. The Caption window will appear In this window enter the caption you would like to appear 

under your picture or object in the Caption section. This window also gives you more 

options to format your caption. In the label dropdown menu you can choose from Equation, Figure, or Table. The position 

dropdown menu gives you option of above or below the selected item. You can exclude the L label from your caption by checking the 

box. 

MAILING TAB 

 

Envelope : It is used to make printed envelope in different size.  

 

Click on Envelopes             Write the Delivery Address              Click on Option to set the size of envelope & font size             

Click on Add to document  

 

Labels : It is used to Create labels.  

Click on Labels              Write the Address             Click on Option  & Choose the Size of labels             Click on New Document. 
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Mail-Merge : Write a letter than save It ( E.g Letter.docx ) & also make a new database file ( E.g Data.docx  ) & Close the database 

file. Click on start Mail Merge              Select Steb by Step Mail Merge Wizard             Click on next Starting Document.             Click 

on Next Select Receipents             Click on Browse & Select database File ( E.g : Data.docx)             Click on OK in Mail Merge 

Receipent Window            Set the Fields in Letter from Insert Merge Field             Click on Preview Result Button              Check the 

Records by Previous / Next Record Button in Preview Result            Click on Finish & Merge ( Here You Can Mail , Print & See The 

Individual Letter ). 

REVIEW TAB 

 

Spelling & Grammar : It Is Used To Check The Spelling & Grammar Of 

Document.Red Line Shows the Spelling Mistake . & Green Line Mistake shows the 

Grammar Mistake. 

Research : Research command is used to show the Dictionary feature as shown in 

the right side screen.  It was able to find the word with the correct pronunciation 

and also the meaning for you to review.  You can also search references materials such as dictionaries and encyclopedias.  

Thesaurus : It helps you find synonyms and also antonyms of any specific word. 

Set Language : To set the language of any other country. It will effect spelling & grammar option. 

Word count : This lets you find the number of words , Pages ,characters, paragraphs and lines in the document.   

 

New comment : Comments used to  add a comment to your document. The comments work like sticky 

notes. Click the New Comment button you will see a line that goes from the section of the document 

your cursor is to the edge of the page. The Delete button gives you 3 choices. You can delete the selected 

comment, delete all comments shown, or delete all comments in the document. Using the Previous and 

Next buttons you can scroll through each comment quickly. 

 

Track  Change : We can easily manage additions, deletion, any comments and 

formatting changes in an efficient manner using this feature. 

 

 

 

 
The Tracking section is used when multiple people are editing a document. To start 

tracking changes in a document click the down arrow on Track Changes then select 

track changes. This will start the process. To see the different editing marks click the 

down arrow and select Change tracking options. The Track Changes Options window 

will open and let you go through the different changes that will be tracked and let you 

choose specific colors for each user, strikethrough styles etc.When you are finished 

making your changes or looking at the possible changes click OK to exit the window.To 

change the user editing the document click the drop down arrow on Track Changes and 

select change user name.This will open another window you can change the name of the 

user so you can track who is making the changes to the document.The Final Showing 

Markup button lets you view the document as you want to print it. You can choose Final 

shows the document with all the proposed changes included, Original shows the 

document before any changes were made, and Markup shows the document with the 

proposed changes. 

The Show Markup button lets you check or uncheck 

showing the comments, ink, insertions and Deletions, 

formatting, or markup area highlights. By checking or un-

checking these options you can customize the way your 

changes are viewed. 

Click the drop down arrow on the changes button. The first option is Accept and Move to Next. This option will highlight the first 

tracked change you made to your document and change the text back to the default text settings so you will no longer see editing 

marks. Next is the Accept Change. To use this option highlight the change and select this option to change the 

text back to normal. The Accept All Changes Shown Option will be grayed out unless you go back to the 

Tracking section and change your selections in the Show Markup drop down menu. This will change what 

tracked changes are shown in the document and the Accept All Changes Shown selection will become available. 

The last option is Accept All Changes in the Document. If you have review all of the changes tracked and agree 

with them this is an easy way to accept all.The Reject button works the same way you either reject all of the changes, select the changes 

you want shown in using the Show Markup selection in the Tracking section, or go through one at a time. The Previous and Next 

buttons are how you move from one change to another without accepting or rejecting the change. 

 

http://www.free-computer-tutorials.net/word-2007-review.html
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Click the Protect Document button. You will see an options pane on the right side of your 

working screen. Click On Protect Document               Click on restrict formatting & editing  

Click on   formatting restrictions in which you can not apply any formatting in protected 

document. 

Click on   Editing restrictions in which you cannot edit in protected document 

Click on yes start enforcing protection button than enter the password 

After this process required protection is apply on a document. 

To remove protection click on stop protection button than enter the existing password 

 

 

                VIEW TAB 

When you click on the Print Layout button in the Document Views section this will change the 

view of the document you are working on to look just like the document will print. 

The next button, Full Screen Reading, changes the view of the document to a larger view that 

takes up most of the screen and removes the buttons at the top to maximize the view for easy 

reading and editing. If you choose this view click the close button at the top right corner to 

return to the normal view. 

The Web Layout button will change the view of the document to appear as it would if the pages were turned into a web page. 

The outline button will show your document as an outline then give you another tab with more outlining tools. 

The last button, Draft, will give you a chance to view your document as a draft for quick editing. This view removes elements of the 

document such as headers and footers for easy editing. 

This section used to show or hide the option. The first option is Ruler. If this box is checked you 

will notice a ruler at the top and along the left edge of your document. This can be helpful to let 

you know how far down or across the page you are. It can also help with centering and aligning 

objects on the page. The Gridlines option will make your page look like a piece of graph paper. 

Document Map will open a pane in the left margin of your document with a few lines of text from 

each page so you can easily navigate through your document by clicking on the sections. 

Thumbnails are similar to Document Map. They are small pictures of each page of your document. Thumbnails also open a pane in the 

left margin with a small graphic of each page in your document. 

The Zoom button will open the Zoom window. The zoom window gives you the options to zoom in or 

out on the document. The default zoom is 100%.The One Page button will let you see the entire page 

all at once. Two pages button will let you see 2 pages next to each other. The Page Width button 

zooms in so the width of the page matches the width of the window. 

The New Window button let you open a new Word 2007 window with the document you are currently 

working on in a different view. 

The Arrange All button will tile all of the Word 2007 documents 

you have open and put them side by side. 

The Split button will split the current document into 2 sections so 

you can view different parts of the document at the same time. 

The View Side by Side button will be grayed out unless you have 

more than one Word 2007 document open. If you have multiple documents open the click the button and it will place 2 documents side 

by side like in a book. This will push all of your buttons together so you may need to do some looking to find what you need. The last 

button we are going to talk about is the Switch Windows button. If you have multiple Word 2007 documents open when you click the 

down arrow on the Switch Windows button it will give you a list of open Word documents to select from so it is easy to switch 

between your documents. 

A macro is a series of commands and instructions that you group together as a single command to 

accomplish a task automatically.                                                                        

Record Macro : It is used to make macro. We can assign macro to button( Mouses)  or keyboard 

View Macro : It is used to view existing macro. 
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SHORT CUT KEYS 

 

Alt+Shift+F7 
Display The 

Research Task Pane 
Ctrl+5 Set 1.5-Line Spacing. Ctrl+Shift+* 

Display Nonprinting 

Characters 

Ctrl+Spacbar 
Remove Character 

Formatting 
Ctrl+Shift+W Underline Words Ctrl+Shift+D Double-Underline  

Ctrl+Shift+F 
Open The Font 

Dialog Box 
Ctrl+Shift+< 

Decrease Font Size One 

Value 
Ctrl+[ 

Decrease The Font Size By 

1 Point. 

Ctrl+Shift+E 
Turn Change 

Tracking On Or Off 
Ctrl+Shift+> 

Increase Font Size One 

Value 
Ctrl+] 

Increase The Font Size By 

1 Point. 

F1 Help Ctrl+F6 
Go To The Next 

Window 
Shift+F3 Change Case 

F5 Goto Ctrl+F10 
Maximize The 

Document Window 
Shift+F4 Find 

F7 
Spelling & 

Grammar 
Ctrl+F12 Open Shift+F5 Go To The Previous Work 

F12 Save As Alt+F4 Exit Office Word 2007. Shift+F6 Display A Shortcut Menu 

Ctrl+F1 
Show Or Hide The 

Ribbon 
Alt+F5 

Restore The Program 

Window Size. 
Shift+F7 

Thesaurus  

 

Ctrl+F2 Print Preview Alt+F7 

Find The Next 

Misspelling Or 

Grammatical Error. 

Shift+F10 
To Open Right Click 

Menu 

Ctrl+F4 Close  The Word Alt+F8 Run A Macro. Shift+F12 Save 

Ctrl+A Select All  Ctrl+I Italic 
Ctrl+S or 

SHIFT+F12 
Save 

Ctrl+B Bold Ctrl+J Justify Ctrl+U Underline 

Ctrl+C Copy Ctrl+K Hyperlink Ctrl+V Paste 

Ctrl+D Duplicate Or Font  Ctrl+L Left Align Ctrl+W Close the Current File 

Ctrl+E Center Align Ctrl+N New Ctrl+X Cut 

Ctrl+F Find 
Ctrl+O or 

Ctrl+F12 
Open Ctrl+Y Redo 

Ctrl+G Goto 

Ctrl+P or 

Ctrl+Shift+F12 

 

Print Ctrl+Z Undo 

Ctrl+H Replace Ctrl+R Right Align CTRL+SHIFT+C 
Copy Formatting From 

Text 

Alt+Shift+T Insert Current Time Alt+Shift+D Insert Current Date  ALT+CTRL+N Draft View 

ALT+CTRL+P Print Layout View ALT+CTRL+O Outline View F4 Repeat Last Action 

ALT+CTRL+I 
Switch in or out of 

print preview 

CTRL+SHIFT+

A 

Change into Capital 

letter 
CTRL+2 

Double space between 

lines 

CTRL+SHIFT+

V 

Apply Copied 

Formatting to Text 
CTRL+1 

Single space between 

lines 
CTRL+SHIFT+G 

Open the Word Count 

Dialog Box 


